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Chapter 4

ANALYZE AND EXPLORE SOUND
Soundscape ecologists use sound to answer a wide variety of scientific questions, and these 
diverse questions necessitate diverse study methods. In this chapter students will learn about the 
development of scientific questions and study methods, and they will design their own studies 
around questions of their choosing. Students will also discover that there are many ways to 
qualitatively and quantitatively describe sound, and they will explore sound visualization as a tool 
for soundscape description and analysis.
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Learning Objectives:
Students will 1) define sound visualization, 
2) learn to use Audacity to visualize and 
manipulate audio files, 3) learn to analyze 
and interpret oscillograms and spectrograms, 
and 4) explore artistic uses of sound 
and soundscape recordings by creating a 
soundscape composition.

Materials:
•	 4 Audacity Audio Libraries
•	 Computers with Audacity installed
•	 Printed oscillogram and spectrograms 

(Sheets 11.1 and 11.2, optional) 
•	 Headphones
•	 Speakers

Expected Time:  60 – 120 minutes
Group Size:  2 – 3 students

Setting:  Indoors

Activity 11: Audio Visualization
Soundscapes contain a wealth of information about the world around us. If you close your eyes and listen carefully, 
you will probably be able to guess your location, the time of day, and some events occurring nearby: Is it quiet? 
What kinds of sounds do you hear? Are you near flowing water? Are you in a forest or an open prairie? Are you 
listening in the morning or at night? Even when you are not paying conscious attention to what you hear, your 
brain is analyzing the soundscape around you to provide clues about the nature and activity of your surroundings. 
Because it is difficult or even impossible to listen to all of the recordings collected by these automatic recorders, 
soundscape ecologists use visual representations of sound called oscillograms and spectrograms. In just one second, 
they can see an entire recording and pick out interesting features.
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INSTRUCTOR DIRECTIONS
In this activity, students will use audio visualization 
software to visualize different audio files. Instructions 
are provided based on Audacity, but other programs 
could be used if desired. There are several audio 
libraries that relate to different parts of this activity. 
Each audio library has a different collection of audio 
files that students can use and manipulate to achieve 
the objectives of each activity stage. 

SOUNDSCAPES AS DATA 
While the soundscapes that we hear may be memorable, 
humans are incapable of perfectly preserving or 
recalling sound without the aid of technological devices. 
Thankfully, microphones and audio equipment allow us 
to preserve and replay sounds that are nearly identical 
to their original forms. Microphones are much like 
our ears in that they detect sound using a thin, flexible 
membrane that is sensitive to pressure changes in 
its surrounding medium (like the human tympanic 
membrane, or eardrum).

In digital audio recording, the displacement of this 
membrane is recorded many times per second (44,100 
for CD-quality recordings). This number is referred to 
as the “sampling rate,” and because it is a measure of 
frequency, it is expressed in Hertz (Hz). When sound is 
recorded in a digital format, it is essentially reduced to a 
series of pressure measurements plotted against time—a 
relatively simple form of data. Digital sound data can 
thus be portrayed and analyzed in many different ways.

AUDIO VISUALIZATION
If soundscape ecologists had to listen to all of their data, 
they would never accomplish anything! Soundscape 
studies typically record far too many hours of audio 
for practical aural analysis. Luckily, there are other, 
more efficient ways to analyze audio data. One tool 
for quickly understanding the content of recorded 
sound is audio visualization. Audio recordings can 
be visualized in several different ways using a variety 
of software. Two primary audio visualizations are the 
oscillogram (waveform) and the spectrogram (Figure 
11.2). An oscillogram is a two-dimensional graph with 
x- and y-coordinates. The x-coordinate represents time, 
and it is usually measured in seconds or milliseconds. 
To follow the change in sound over time, read an 
oscillogram from left to right. The y-axis represents 
amplitude, and it is typically measured in decibels (dB).

A spectrogram provides one more dimension of 
information because it is a three-dimensional 

representation of sound. Like an oscillogram, it notates 
sound’s amplitude over time, but it adds an additional 
axis that denotes frequency, measured in Hertz (Hz). 
Time is still presented on the x-axis, but frequency 
replaces amplitude on the y-axis. To make room for 
amplitude without creating a visual mess, its variation 
is often portrayed through variation in color. Thunder’s 
low-frequency rumblings occupy the bottom part of a 
spectrogram, while the higher-frequency trills of birds 
would occupy higher positions.

Audio visualization tools are important to soundscape 
ecologists, acoustic scientists, and even musicians. 
These tools allow them to “see” sound, and with this 
capability, the characteristics of recordings that are 
minutes, hours, or even days in length can be seen at 
a single glance. The occurrences of certain acoustic 
events can also be quickly located without skimming 
through hours of audio. Many programs allow for quick 
switching between different types of visualizations, 
zooming, and even custom coloring.
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Figure 11.1. Sound visualizations of a northern cardinal call in Audacity. A) An oscillogram presents the 
amplitude or loudness of the sound. B) A spectrogram presents 1) time, shown on the x-axis, 2) frequency, 
shown on the y-axis

A.

Time (in seconds)

Fr
eq

ue
nc

y

B.

Amplitu
de

Pre-Activity
Students will need to have access to a computer with 
one of the audio visualization programs installed. 
Alternatively, printed copies of spectrograms can be 
provided if students do not have computer access 
(Sheet 11.1).
1.	 Start by playing a northern cardinal sound from 

Audacity Audio Library 1 for students, and ask 
them to make a creative drawing representing the 
sound they are hearing. 

2.	 Show them the corresponding spectrogram, either 
on paper or with Audacity. 

3.	 Notice if there are any similarities between the 
students’ drawings and the spectrogram.

4.	 Give them some time to explore the spectrogram 
and then explain how they can read a spectrogram. 

5.	 Play the sound file several times and show the 
corresponding spectrogram for students to become 
acquainted with the spectrogram.
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1.	 Instruct students to drag each sound file 
separately from the Audacity Audio Library 1 
to the Audacity icon, or to import each file by 
selecting the menu option “File > Import” and 
selecting the file from its folder (Figure 11.3, 
top left). Each file will be placed in a separate 
“track” that starts at 0 seconds. The imported file 
will appear as one “channel” if it was recorded 
in “mono” (with one microphone) or with two 
channels if it was recorded in “stereo” (with two 
microphones) (Figure 11.3, bottom). The buttons 
on the control panel, in order, are pause, play, 
stop, skip to the beginning, skip to the end, and 
record (Figure 11.4).

2.	 Instruct students to hit the “Play” button for each 
sound while viewing it as an oscillogram.

Activity Part 1: Audio Visualization
Audacity Audio Library 1 is composed of different 
isolated sounds that will help students become familiar 
with viewing audio visualizations while listening 
to corresponding recordings. Students can play the 
different sounds and explore how time, frequency, and 
amplitude are represented visually.

Audacity Audio Library 1: 
•	 Airplane and Bird
•	 Birds
•	 Coyote
•	 Northern Cardinal
•	 Thunder
•	 Wind

Figure 11.2. A) Importing a file; B) stereo and mono tracks.

A.

B.

Stereo

Mono



Analyze & Explore Sound

92  The Science of Soundscape Ecology

4

Figure 11.3. Control panel.
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KEY QUESTIONS

What is the length of each sound in Audacity 
Audio Library 1? Describe the length using a 
standard timecode format of hours, minutes, and 
seconds (00:00:00).
Answer: See the description of Audacity Audio 
Library 1 in Activity Part 1.
What is the frequency of each sound? (Hint: 
Look at the y-axis. The numbers you see are 
frequency values. A sound might occupy a range 
of frequencies.)
Answer: See the description of Audacity Audio 
Library 1 in Activity Part 1.
What is the difference between the recordings within 
this audio library and those in other libraries?
Answer: This library contains multi-source 
soundscapes while the other sound libraries included 
distinct sounds from single sources.
What are the sound sources in each recordings?
Answer: Alaska_20140810_133000: birds and 
frog; Borneo_015116_20140209_183000_000: 
birds, cicadas, and breaking tree branches; Costa 
Rica_20150422_054500: Cicadas, birds, and 
howler monkey; Nebraska_20150321_172200: 
cranes and songbirds; Indiana_20120501_063000: 
geese and songbirds.
Are these sounds examples of geophony, 
biophony, or anthrophony?
Answer: All of them are biophony, except for the 
breaking tree branches that are geophony.

3.	 Make sure they listen to each sound and watch the 
playhead move along the oscillogram (Figure 11.5). 
There are different visualization options in audio 
software. In Audacity, you can view sound as an 
oscillogram or as a spectrogram. Remember, a 
spectrogram shows three dimensions of sound.

4.	 Ask students to click on the arrow next to the name 
of the track at the left of each track. A drop-down 
menu will appear. They should select “Spectrum” 
(Figure 11.6), and notice that the one-colored 
oscillogram will be converted to a multi-colored 
spectrogram. Instruct students to view all of 
the sounds in Audacity Audio Library 1 as 
spectrograms. Show students how to listen to all of 
the tracks at once by pressing the “Play” button or 
to listen to one sound file by pressing the “Mute” 
button to mute tracks they do not want to hear 
or by pressing the “Solo” button to play the single 
track they want to hear (Figure 11.7).

5.	 Ask students about the advantages and 		
disadvantages of oscillograms and spectrograms.

6.	 Remind students about the three dimensions of 
sound displayed in a spectrogram.
•	 Time moves from left-to-right, and is 

represented on the x-axis.
•	 Frequency is represented on the y-axis.
•	 Amplitude is represented by color brightness on 

the z-axis.
7.	 Encourage students to explore the different 

aspects of spectrograms. If they like, they can 
highlight different parts by clicking and dragging 
with their mouse and then pressing the space bar 
to play that excerpt.

8.	 Ask them to identify sounds with high and low 
frequencies, high and low amplitudes, and different 
durations and rhythms.

As students improve their skills, they will be able to 
recognize how different species are located in certain 
frequency ranges and have certain visual patterns. 
They may also be able to recognize thunder, rain, or 
car sounds.
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Figure 11.4. Oscillogram of a bald eagle call.
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Figure 11.5. Changing oscillogram to spectrogram.
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Activity Part 2: Match up the Sounds
Audacity Audio Library 2 has six samples of animal 
sounds that are typical in six different biomes. These 
animal sounds are paired with pure tones that match 
the animal sounds’ frequencies.

Audacity Audio Library 2:
•	 Bald eagle, Alaska, Tundra (1,900 Hz)
•	 Bird, Arizona, Desert (8000 Hz)
•	 Coyote, Indiana, Temperate forest (620 Hz) 
•	 Bullfrog, Maine, Estuary (200 Hz)
•	 Siamong monkey, Borneo, Rainforest (3,126 Hz)

1.	 Ask students to drag an animal sound and a pure 
tone to the window (you will have two tracks in the 
same window).

2.	 Play the animal sound. Then, play the pure tone. 
Then play both sounds simultaneously. 

3.	 Ask the students to match all of the animal sounds 
with the correct pure tones and to write down the 
dominant frequency for each species.

Activity Part 3: Complex Soundscapes 
Audacity Audio Library 3 has more complex 
soundscapes, with multiple sound sources making 
sounds at various frequencies and temporal patterns. 
Scientists use various naming conventions to help 
them identify files. The convention generated 
by Song Meters is [Song Meter Serial Number]_
[YearMonthDay]_[HourMinuteSecond]. For instance, 
015116_20110416_150000 means:

Song Meter Serial Number: 015116
Date: 2011/04/16 (Year/Month/Day)
Time: 15:00:00 (3:00:00 p.m.)

The serial number has been replaced with a location for 
the files in this library.

Audacity Audio Library 3:
•	 Alaska_20140810
•	 Borneo 015116_20140209
•	 Costa Rica 20150422
•	 Indiana_20120501
•	 Nebraska 20150321

1.	 Explain to students the differences between sound, 
noise, and soundscapes. Sound has one source, like 
a single animal. A soundscape is the product of a 
combination of different sound sources, like a bird, 
cricket, and running water. Noise can be any sound 
that masks a signal. For instance, birdsong can be 
masked by the noise of traffic or rain.

2.	 Ask students to drag and drop each soundscape 
from Audacity Audio Library 3 into separate 
windows of Audacity. Students should repeat the 
steps outlined in Part 1.

3.	 Then ask the following key questions.

Frequency Animal

1,900 Hz Coyote

8,000 Hz   Siamang Monkey

200 Hz Arizona bird

700 Hz Bald Eagle

620 Hz Bullfrog

Table 11.1. Animal sounds matched with their 
frequencies.








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Activity Part 4: Match the Soundscape 
with the Spectrogram
For this activity, students are given 5 printed spectrograms 
(Sheet 11.2). Then, by accessing Audacity Audio Library 
4, they will match the printed spectrograms with the 
corresponding soundscape recordings.

Audacity Audio Library 4:
•	 Alarmers tropical cops 20140218
•	 Isolated trumpeter 20140314
•	 Natures rowingmachine20130208
•	 Onecrazybird 20140210
•	 Shrieking me out 20140117

1.	 Play each recording in a random order without 
showing their spectrograms. Students can work in 
groups and should try to describe why they chose 
each specific spectrogram for each soundscape.

2.	 Next, ask students to identify where the soundscape 
might have been recorded. Location clues might 
include types of animal sounds, presence and types 
of water sounds, and presence of wind. Students 
have access to information about several ecosystems. 
Have students use these resources to match the 
soundscapes to their corresponding ecosystems. 

KEY QUESTIONS
How did you match the spectrograms to the 
recorded soundscapes? 
Answers will vary.
To which category do the sounds in each 
recording belong (geophony, biophony, and 
anthrophony)?
Answer: Biophony
When and in what season were the recordings 
made? (Hint: check the file names.)
Answer: Alarmers tropical cops 20140218_0630: 
6:30am on February 2014; Isolated trumpeter 
20140314_1800: 6:00 pm on March 2014; 
Natures rowingmachine20130508_1200: 12:00 
pm on Mary 2013; Onecrazybird 20140210_0500: 
5:00 am on February 2014; Shrieking me out 
20140117_1800: 6:00 pm on January 2014
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Activity Part 5: Create a
Soundscape Composition
In this part students can combine different sounds from 
any of the audio libraries to make their own innovative 
soundscape compositions. Soundscapes can serve as 
inspiration or models for imitation. Encourage them to 
get creative! One way to do this is by using some effects 
in Audacity.
Useful Audacity tips:
1.	 Click and drag to highlight sections of audio (like 

in a text document). Press the space bar to play and 
pause any sound excerpt.

2.	 Select an entire track by clicking the gray area to the 
left of the oscillogram, where the track name is listed.

3.	 In a multi-track session where you have more than 
one sound file imported into the same window, mix 
the sound by adjusting the track levels.

Experiment with Audacity’s easy-to-use effects by 
exploring the “Effects” menu located on the top 
menu bar. “Reverse,” “Equalization,” “Change Pitch,” 
“Change Speed,” “Change Tempo,” “Fade In,” and 
“Fade Out,” can be applied to an entire track or to 
highlighted sections of a track.

Reverse: plays the sound in reverse
Equalization: amplifies or reduces certain frequencies 
in the sound

Figure 11.6. Audacity toolbar.
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Change Pitch: raises or lowers the pitch
Change Speed: raises or lowers the speed (pitch will be 
altered as well)
Change Tempo: raises or lowers the speed without 
affecting the pitch  
Fade In: makes the beginning of a highlighted 
section inaudible, while creating a gradual increase in 
amplitude to the end of the highlighted section, which 
is kept at the original amplitude
Fade Out: opposite of “Fade In”

Students can also manipulate sounds by using different 
options in the toolbar (Figure 11.8).
1.	 Introduce students to some of these tools 

in Audacity.
2.	 Let them explore the audio libraries, import files, 

and creatively combine and edit to craft their own 
unique soundscape compositions.

3.	 After students finish creating their own soundscape, 
they should click on “File” > “Export...,” choose a 
file name, and save the file in a “WAV (Microsoft) 
signed 16 bit PCM” format. Then, they can share 
their new creations. They can also click on “File 
>”Save Project As...” to save their Audacity projects 
to continue experimenting with soundscape music 
outside of the classroom.
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POSSIBLE EXTENSIONS
Revisit recordings from previous activities, and visualize 
and describe those sounds using Audacity.

ADAPTATIONS FOR ACCESSIBILITY
•	 Walk students through each step.
•	 Provide a thermally-printed copy of spectrograms 

and oscillograms for each student
•	 Play each audio recording several times and 

guide the students through interpretation of the 
oscillogram and spectrogram.

•	 Ask students to rotate the paper ninety degrees, as it 
is easier to follow the stereo recording by touching 
the left and right channels with the left and right 
hand, separately.

KEY QUESTIONS

What is the length of each sound in Audacity 
Audio Library 1? Describe the length using a 
standard timecode format of hours, minutes, and 
seconds (00:00:00).
Answer: See the description of Audacity Audio 
Library 1 in Activity Part 1.
What is the frequency of each sound? (Hint: 
Look at the y-axis. The numbers you see are 
frequency values. A sound might occupy a range 
of frequencies.)
Answer: See the description of Audacity Audio 
Library 1 in Activity Part 1.
What is the difference between the 
recordings within this audio library and 
those in other libraries?
Answer: This library contains multi-source 
soundscapes while the other sound libraries included 
distinct sounds from single sources.
What are the sound sources in each recordings?
Answer: Alaska_20140810_133000: birds and 
frog; Borneo_015116_20140209_183000_000: 
birds, cicadas, and breaking tree branches; Costa 
Rica_20150422_054500: Cicadas, birds, and 
howler monkey; Nebraska_20150321_172200: 
cranes and songbirds; Indiana_20120501_063000: 
geese and songbirds.
Are these sounds examples of geophony, 
biophony, or anthrophony?
Answer: All of them are biophony, except for the 
breaking tree branches that are geophony.
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Sheet 11.1: Spectrogram and Oscillogram of a Northern Cardinal’s Song
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Sheet 11.2: Spectrograms of Different Soundscapes
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